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Waarom BIM gebruiken?

Voordelen

* Tijdswinst
 Kwaliteitsverbetering
 Coherentie tussen 2D en 3D
 Dalen faalkosten project
 Betere samenwerkingsmethodiek

Aandachtspunten Phase O Phase 1 Phase 2 Phase 3
 Eerste opzet vraagt tijd
* Consequent werken = afspraken maken!
* Gradueel invoeren (=Stappenplan)
. Lifecycle
IBIM
BIM Management
Cloud
2D 3D 4D, 5D Computing 6D, /D

Models, object}, collaboration

Drawings, lines, arcs, text, etc. Integrated Interoperable Data

CAD maturity

-

BIIM maturity
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Introductie tot BIM

Definities OPEN BIM m BIM

OPEN BIM

Betreft een standaard methode om het BIM model te beschrijven in informatie en geometrie,
waarbij software keuze geen bepalende factor Is.

DOEL

Samenwerking tussen alle partijen in de bouwkolom op basis van een open uitwissel standaard.
Beschikbaarheid van data in een latere levenscyclus van gebouwen (o.a. Facility Management)

GRAPHISOFT.

©/DDS-CAD MagiCAD™ “?*" TEKLA soLiBri ARCHICAD

AUTODESK

REVIT

ITODESK
VISWORKS

D

by AF
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Introductie tot BIM

Industry Foundation Classes
N
&
wat is IFC?

Het uitwisselformaat van gebouwmodellen
* Omschrijft geometrie en informatie
» (Gestandaardiseerd en gespecificeerd op ISO normen
» Ondersteund door diverse BIMsoftware
» Building Smart beheert de specificatie van IFC
» Huidige versie IFC 2x3 (TC1).

IFC is niet BIM
BIM houdt niet in dat er één centraal IFC model is vanuit waar alles wordt gegenereerd.

Referentiemethode
De eigen deelmodelinformatie wordt vergeleken met de andere
.o . . AUTODESK ]
deelmodellen / Aspectmodellen / Codrdinatiemodellen A - N SIMULATION @T""a’c
ETABS AXIIVM
H RRRRNRRARRNY Inpm
NEMETSCHEK
| Scia
9 - [ RAPHISOFI'.-// P~ ANALYSIS
2 = ‘ARCHICAD €= DETAILING

“3%° TEKLA Structures Bentley

AUTODESK “ RRRRRRRRRRYY

REVIT NEMETSCHEK
STRUCTURE AIIpIan
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Introductie tot BIM

wisselwerking - “Open BIM"

/)
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Introductie tot BIM

Hoe werken met BIM?

BIM-uitvoeringsplan
Bepaal de informatie behoefte in verhouding tot fase gebonden samenwerking.

VO-DO etc. - LOD?

Bepalen van de fasering voor de samenwerkingsvormen :
* Ontwerp - LOD 100-300

» Aanbestedingsfase - LOD 350

» Uitvoeringsfase - LOD 400

* Oplevering - LOD 500

» Beheer - ?
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Introductie tot BIM

Hoe werken met BIM?

Voorbeeld Ontwerp

» Samenwerking opdrachtgever architect en adviseurs
» Ulitwerken ontwerp in onderling overleg

» Abstract niveau; vloerveld, geen vloerelementen

» Voorkomen van conflicten tussen de disciplines

Voorbeeld Uitvoering

» Samenwerking hoofdaannemer met onderaannemers en leveranciers
» Passen de te leveren bouwdelen in het geleverde ontwerp?

» Specifiek niveau; vioerelementen

» Voorkomen van conflicten tussen de leveranciers
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Introductie tot BIM

Hoe werken met BIM?

INTEGRATED PROJECT DELIVERY PROTOCOL (IPDP)
m B l M OPEN-BIM START DOCUMENT KUBUS

B I M — p rotocol — architectural solutions
* Vastleggen van afspraken tussen partijen. -
* Wissel alleen informatie uit die bij het eigen SHRLVING PROUECT
kennisgebied hoort. _PROJECTIAA
PROJECTNUMMER OPDRACHTGEVER
ADRES/LOCATIE
BESCHRIJVING PROJECT
Waarom een Protocol CONTRACTVORM PROJECT AFSPRAKEN
) . ) ) KERNTEAM / PARTNERS PARTNER
» Duidelijkheid over verwachtingen R P GEZAMENLIJK REF.PUNT/NULPUNT  alle partners
. ° OPDRACHTGEVER BESTANDSNAMEN
- Vastleggen van informatiebehoefte e e T LT LChS
. .o . INSTALLATIE ADVISEUR LIJST VAN UITSLUITINGEN
Gezamenlijke uitgangspunten IS TERADSEUR LIJST VAN WIJZIGINGEN BIJ UPLOAD
» Wie is verantwoordelijk voor wat en per fase SoumANACEVEN HIJST VAN ONVOLLEDIGHEID
OBJECTDEFINITIES
+ Contactpersonen BIM-MANAGERS * e PROJECTSITE
N | t ) %F{CI-(;ITECT aanvullen
® u u n PDRACHTGEVER
P SO TRUCTEDH PLANNING MODELONTWIKKELING
S OMSCHRIJVING PER FASE
I P D P olan een bijeenkomst om

Integrated project delivery protocol

Het is noodzakelijk om de informatie overdracht vast te leggen en regels op te stellen.

Voorbeeld is hier te downloaden:

http://www.kubusinfo.be/openbim/OpenBIM/Download-IPDP OPMERKINGEN PROJECTPARTNERS

aanvullen

* VERANTWOORDELIJKHEDEN

BIM-MANAGER controleren en bewaken’
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‘BIMmen' met ARCHICAD

Element Classifications

Wat doen deze Element Classifications?

Z0'n Classificatie is standaard voorzien in de ARCHICAD element settings,
onder Categories & Properties.

Deze Classificaties zijn van belang bij het uitwisselen naar |FC, zodat de andere partij(en)
diezelfde elementen juist kunnen herkennen na het inlezen van het IFC bestand.

GRAPHISOFT.

ARCHICAD

ORON | Slab Default Settings

ﬁ Default

v 0! GEOMETRY AND POSITIONING

@ Info € ~ » ~ (@ FEE O
%4‘1 - — ¥ (C) Object.0.1
==]-= Location Quantities Material >
; Property Value
o Model (C) Morph
‘.5 J I\ D ALG Vloer 20 > Discipline Architectural
| " Name Morph-x
Home Story: -
. . A — — o Type ALG - BINNENAFWERKING
0. Gelijkvloers (By Elevation) C F e % o( TP
" " Material ALG - BINNENAFWERKING
to Project Zero >  Reference Plane: Layer ArchiCAD Layer
: 7 System
W | o000 z A, A A Geometry Boundary Representation
- Application ArchiCAD-64
GUID 10e_mJrjy3HeTR1S0VBRWSs
BATID 40A3EC13-D6DF-0346-875B-07F...
» L3 FLOOR PLAN AND SECTION
» &% MODEL
¥V |E| CATEGORIES AND PROPERTIES
Element Classification: Slab >
ID AND CATEGORIES

ID Vloer-x
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‘BIMmen' met ARCHICAD

Element Classifications

~ Pset_CoveringCommon

[0 AcousticRating IfcLabel
[] Combustible IfcBoolean
[J Finish IfcText
[0 FireRating IfcLabel
[J] FlammabilityRating IfcLabel
[] FragilityRating IfcLabel
Material @ ALG - BINNE... IfcLabel
[] Reference Ifcldentifier
[] SurfaceSpreadOfFlame IfcLabel
* [] TotalThickness IfcPositiveLengthMeasure

e 4 Element Classification Ceiling

e & Element Classification

1 AcousticRating fcLabel
Combustible fcBoolean
Compartmentation fcBoolean
FireRating fcLabel
IsExternal FALSE IfcBoolean
LoadBearing TRUE IifcBoolean
PitchAngle fcPlaneAngleMeasure

GRAPHISOFT. Reference fcldentifier

ARC H IC AD SurfaceSpreadOfFlame fcLabel

ThermalTransmittance fcThermalTransmittanceMeasure
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-‘ — Header Options > I fﬂ Selected: O Editable: O B (b5 ULd O
- v OD Woning J-L
Design  Freeze Schedule Header Scheme Settings... "L Start BE
B ot r v nn 80 e e e 1000 e e e e 3500 e e e e e 200 _|) start 3D BE
= = Element v [ Archicafé - 2017 02
' Layer Full Element ID eyl Structural Function 0. Gelijkv!
Al Y Classification O Getloers
- : ecklist vloeren
23 Vloeren Garagevloer Slab Load-Bearing Element |Ir -
% - — . 4 SO - Schetsontwerp
% _ 1123 Vloeren Vloerplaat - gelijkvloers Slab Load-Bearing Element |Ir s P VO - Vanrantwarn
] | |23 Vloeren vloerplaat - keldgr | Slab ° S
| 123 Vloeren vloerplaat - verdieping Slab o < v CRITERIA | IFC CHECKLIST VLOEREN
E 27 Daken Dakrand COV‘ o N . ( : . Criteria. - Value ) and/or
— = - = ement Type is a
EB 8_ BA-AQ7 Stat. Form. - Gebouwoppervlakte totaal
] 27 Da ken Da kra nd COV( BA-AQO8 Stat. Form. - Totaal volume
% — BA-A11 Stat. Form. | - Parkeerplaatsen
% - 27 Daken Dakl’and COV‘ BA-A12 Stat. Form. | - Sanitafire voorzie.ningen
BA-ALG Stat. Form. - Zones info checklist
% v - ' . N BE-RWT Regenwatertoets - voorbereiding
® - | |27 Daken Plafondafwerking buiten Ceili bi Merken
= bi 2 Gespiegelde merken checken
% _ 27 Daken Plat dak ROO1 bi 3 Visuele controle
(¢ 27 Daken Plat dak Roo bida  Output1op 50 N .
[Zb o BU”( bi 4b Output 1 op 100
§ 4 1 Bui t d fW D | d | d = bu 1 Merken ¥ FIELDS / IFC CHECKLIST VLOEREN
Window ultenwanaa Orpe - door Open en bu 2 Gespiegelde merken checken = Name L s o
S a -_ Prox bu 3 Visuele controle A k Layer |
A 41 B t d fW G I I t C bu 4a Output 1 op 50 = k Full Element ID l
f _ urnenwanaa eve p dd OV bu 4b Output.1 op 100 . k Element Classification l
©Q° _ _ . . IFC Checklist vioeren s+ [ Structural Function l
B 82 Interieur Binnenplaat afwerking Cove FC-2  BB/SfB (2 cilfers) « & Pposition |
. : : : Meetstaat Installatie s h IFC Type !
® 1190 Terrein omgeving Funderingsbalk Beal  mzMeetstaat Ramen en deuren )
- — : —— _ . o + R IFC Type Product Name |
bocume | 199 3D hulplijnen hidden |Garagepoort - Hulpbelijning | Site Meetstaat Rio . s [X] Compartmentation (Pset_SlabCommon) |
@ - . . e . . Meetstaat Transportvoorzieningen
- | 199 3D hulplijnen hidden |Garagepoort - Hulpbelijning |Site . \eetetast  Trappen
£ 199 3D vis aankleding  |Buitenverharding Plate¢ v components |
More 150% | > k| Pt Kleur- en materiaalstaat Add Fields... Y Remove
;tion Area. Press and Hold Ctrl+Shift to Toggle Element/Sub-Element Selection. — New... Delete _@ D;> Cancel “

e



‘BIMmen’ met ARCHICAD
ARCHICAD properties

Wat zijn Properties?
Dit zijn 'Niet visuele' instellingen van een element.

Hierbij wordt het BIM model als centrale opslagplaats voor alle bouw gerelateerde data gebruikt.

Hoe kunnen Properties toegepast worden?

ARCHICAD Properties worden aan 3D elementen en zones gekoppeld.
ARCHICAD Properties zijn beschikbaar volgens hun Element Classificatie.
ARCHICAD Properties kunnen opgeroepen worden in:

ARCHICAD Properties kunnen weergegeven worden in een Graphic Override

Schedules,
Labels,
Zone Stempels,

Favorieten,
Find&Select

$KS

i ifec #f

ArchiCafe-15

Q

» B Main

> Model View

I 3 Geometry

» & Construction

P Positioning

> Jz Floor Plan and Section

v % Surface and Materials

% Building Material

% Building Material ID
% Building Material Name
% Edge Surface

% Inside Face Surface
% Outside Face Surface
% Surface
% Surface Name
> @ Identification
» 83 IFC
v D Properties
» B AFWERKING
» W ALGEMENE EIGENSCHAPPEN
» B BEGLAZING
» B CONSTRUCTIEVE EIGENSCHAPPEN
» W BOUWFYSISCHE EISEN
» W MILIEUPRESTATIE
» % PRODUCTIE
» & PRODUCTINFORMATIE
» & VEILIGHEID ALGEMEEN
» & VEILIGHEID BRAND
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‘BIMmen' met ARCHICAD

@ Label Selection Settings ® Scheme Settings
Informatie Beheer e T
. ID A Name
v Type and Preview . . New...
yp ITip bekijk ook de KME module Schedules
o o T Bouwfase - invullen Rename...
rofiel naam ... arker
Favo ri et en i Checklist objecten Selet
) elete
- .
0 T ) Checklfst wanden o
S— Wall Checklist wanden per verdieping Import...
Load-Bearing Element
IdentificatieLa Label Object label = Elektra per zone
bel 19 maatvoering ... 19 KM Morph m2/m3 per verdieping Export...
.';“. L i i
Labels e - .
- 5 ¥ Criteria /| Bouwfase - invullen
s
Opbouwlabel Ramen en Surface label ( Criteria Value ) and/or
E (anc) - $ Element Type is <3 Slab and
S C h e d u I es . ¥ . - "‘f'“ - $ Element Type is & Roof and
% e R ' ¢ Position is Exterior
Tags en Viiesgevel Warmteweerst
categories la... paneel label ... and 19 KM
» raw Text Style
» +2zY% Pointer
» A& Symbol Label >
N — » A v
¥ 8= Custom Settings
N Add Object Parameters T.
L] Inhoud set-up P p——[ Add IFC Properties LM
- B—
e Maak sortering s abe Bouwfase (KUBUS_Pset_Fasering) l
Toon gegevens volgens Waarde parameter s R Quantity l
| Toen eigenschappen met Property Set Name
P 1. Rij Element Classification
P 2. Rij Structural Function
4. Rij Geen
5. Rij Geen _
6. Rij Geen « (Geen r
s 1 Add... v
7. Rij Geen D
- Geen  Structural Function Add Object Parameters |
o pii Raan o . Cancel
Position Add IFC Properties
/A& Text Label Element Classification
> '&E Taqs and Cateaories Renovation Status
Hide with associated element Show On Renovation Filter

£ @ Tekst/dim 1: 50/100 ~  IFC Type
- ArchiCAD IFC ID

Globalld (Attribute)

Name (Attribute)

Tag (Attribute)

NL/SfB (4 cijfers) (Classification Reference)




‘BIMmen’ met ARCHICAD
ARCHICAD properties

Property Manager

ARCHICAD Properties worden beheerd via de Property Manager.
Te vinden onder het Menu Options > Property Manager...

In de KeyMember template zijn veel gebruikte Properties
voorgedefinieerd.

O
v @
Name

¥ ONDERHOUD

+ Conditiemeting

s Onderhoudsperi...

+ Plaatsingdatum

Type

Option Set
General

General

¥ VEILIGHEID ALGEMEEN

+ Inbraakwering

+ Toegankelijkhei...

Option Set

True/False

+ Doorvalbeveiliging True/False
v VEILIGHEID BRAND

+ Bewegingsmelder True/False

s Brandcomparti...

Option Set

Default

n.v.t.

n.v.t.

dd/mm/yyyy

n.v.t.
False

False

False

n.v.t.

Property Manager

“
Name:

Brandwerendheid

¥ DEFINITION
Data Type:
Preview/Default:

Description:

Option Set

ArchiCafe-17

Editable: 1

n.v.t.

Options Setup...

Geef de brandwerendheid op [min)

+ IFC: 'FireResistanceRating’

Brandwerendheid Option Set n.v.t.

s+ Brandwerendhei...

s Brandklasse

s Compartimenter...

+ Kwetsbaarheids...

s Ontvlambaar

+ Rookbegrenzing

General

Option Set
True/False
Option Set
True/False

True/False

s Vliuchtdeur, -raam True/False

+ Rookcompartiment Option Set

s+ Rookmelder
s Viuchtroute
s WBDBO

s Zelfsluitend

True/False
True/False
Option Set

True/False

Gebruik 'Parame...
n.v.t.
False
n.v.t.
False
False
False
n.v.t.
False
False
n.v.t.

False

~ Show conflicts with Properties in Hotlinks

New...

Delete

]

“ AVAILABILITY

Available for the following Element Classifications:

Al

"None
) Custom

Edit...

Transfer Availability:

L2 £

Tip & Truc 105 Gebruik maken van ARCHICAD Properties

Beam
Ceiling
Column
Covering
Curtain Wall
Footing
Member
Pile

Plate
Ramp

Roof

Slab

Stair

Stair Flight
Wall

Cancel
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Gebruik van bouwdelen

Complex Profiles

Vermijd combinatie van bouwdelen
* Complex Profile gedraagt zich als 1 component
* Gegevens van gecombineerde onderdelen zijn niet of moeilijk los inzichtelijk

(1) Info € ~ 2 ~ [ FHi=li=
J (B)Wall.1.1
Location Quantities Material >
Property Value
Model (B) Profiles
Discipline Architectural
Name Wand-x
Type Dakrand 453 x 579
Description
Material Metaal - Staal C, Metaal - Aluminiu...
Layer 21 Buitenwanden
System
Building Envelope True
Geometry Boundary Representation
Application ArchiCAD-64
GUID 1zZQXM26fmGub3fdSFfph9
BATID 7D8DA856-086A-7043-8183-A6...
ANEMETSCHEK COMPANY
Composites

Bij de IFC export worden Composites als Building Element Parts (BEP) geéxporteerd.

GRAPHISOFT.
Zie hiervoor ‘Conversion Options..." bij de [FC translator. ARCHICAD



‘BIMmen' met ARCHICAD

Gemeenschappelijk nulpunt instellen

Survey point

ArchiCafe-19

Referentieobject voor nulpuntaanduiding, te gebruiken als nulpuntreferentie in uitwisseling met andere partijen. ‘ X:-112.348
Y:-8.181
Stel dit alternatief nulpunt in voor export volgens onderstaande stappen: Z: 0.000
Plaats het object Survey Point
Ga naar File > Interoperability > IFC Translator setup
A Object Selection Settings ? X
Ga naar het tabblad |
. . . ‘ e 17 Q o3»  Survey Point Selected: 1
Export .Optlor.ws > Geometry corwerspn > Conv§r5|9n Op’Flons " Embedded Library e
Zet de instelling ‘IFC Site location (if server Point is available):’ » () Linked Libraries - [ SURVEY POINT SETTINGS
‘ ) o ’ BIMcloud / BIM Server Libraries
op ‘at Survey Point position « B} Buittin Libraries ¢ » | Fn General Settings.. »
B Apartment Stamp.apx Sizes Sign Type
Bl ARCHICAD.DLL M . . M
IFC Site location (if Survey Point is available): At Project Origin v BN ArchiGlazingapx ; B9 mm
.Ex_Finishing.apx Style1 »
B GoogleEarthConnectivity.apx 20.00 b, mm
.IFC.apx ........ +
. SiteMaker.apx | Follow Project North
. TOP Stamp.apx
Text SP
Text Orientation on Symbol Readable 3
SP Text Style
Arial ¥ M.1|5.00 »mm B/ M
» [Z FLOOR PLAN AND SECTION
4 » () MODEL
IFC Member Extruded m » |=| CATEGORIES AND PROPERTIES
R Apply <> Structural - Bearing.IFC Import ’ -m OK

Tip & Truc 109 Alternatief projectnulpunt met het Survey Point
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Uitwisseling met externe partijen

Maken van een IFC-model

1. Filteren van informatie
Alleen zichtbaar maken van de informatie die jij wilt exporteren

2.File » Save As > IFC 2x3 file

o Format: |FC 2x3 file >

3. Kies een IFC Translator -

L ees de bijbehorende omschrijving Export: Visible elements (on all stories) Model Filter...
Translator: General Translator Settings...
Verberg extensie = Nieuwe map Annuleer

4.Visuele controle van het IFC model in een Viewer

Bijvoorbeeld Solibri Model Viewer (gratis)

Verschil Viewer / Modeler:
Een Viewer leest enkel de informatie die in het IFC bestand is opgenomen

Een Modeler vertaalt informatie naar zijn eigen gereedschappen

http://www.solibri.com/products/solibri-model-viewer/

Tip & Truc 090: Het exporteren van een IFC model|
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Uitwisseling met externe partijen .
Filter

Translator - Export

Entire project

v Visible elements (on all stories)
All elements on current story
Visible elements on current story

¥ Export Options

Elements to export: Visible elements (on all stories)

IFC Model View Definition: Coordination View Version 2.0

Name of custom extended view:

Geometrie

Properties to export: Current Scheme properties only

GRAPHISOFT.

Geometry conversion ARC H I C AD Conversion Options...

Derived model data to export Data Settings...

BN | Geometry Conversion Options

| Use BREP geometry for all elements
| Explode Composite and Complex Profile elements into parts

| Export geometries that "Participates in Collision Detection" only

I n fO r m a t ie Multi-skin complex geometries: Complex profiles
Elements in Solid Element Operations: Extruded/revolved
Derived Model Data Settings Elements with junctions: Extruded/revolved without junctions
Space containment Slabs with slanted edge(s): Extruded
Bounding box | Use legacy geometric methods as in Coordination View 1.0
| Geometry of Type Products

IFC Site geometry: As boundary representation (BREP)

IFC base quantities (size, area and volume)

| All ArchiCAD BIM parameters Cancel

IFC Space boundaries

| ArchiCAD Zone Categories as IFC Space classification data

Blog Bond Bryan - mogelijkheden om te filteren
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Export & Import

BREP vs. Extruded
Coordinatie vs. parametrisch

Hoe moet het model uitgestuurd worden?

Extruded geometry

Extruded geometry

Dient het model als basis om verder op te gaan werken?
Precise geometry (BREP)

 Geometrie wordt niet altijd goed geinterpreteerd
door ontvangend BIM-pakket.
* Gebruik de IFC Translator “...Parametrisch model’

BREP - Precise Geometry
Dient het model voor nazicht / codrdinatie?

 Bewerkingsmogelijkheden zijn met BREP beperkt, maar de Geometrie blijft behouden.
 Gebruik de IFC Translator “...Coordinatie model’
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Uitwisseling met externe partijen

O Navigator - Publisher Set

Translator 2 > M S R Y

04 IFC Uitwisseling R

Opslaan van Translators

Vastleggen en hergebruik van import en export instellingen.
Menu File > Interoperability > IFC > IFC Translation Setup...

v [ 7] Model checking en hoeveelheden
IFC Totaal model
v t] Coordinatie modellen

O IFC Translation Setup IFC Bouwkundig model
AVAILABLE TRANSLATORS IFC Constructie model
— — Name A Project Partner Create New... IFC Installatie model
N 01_Bouwkunde coordinatie model NL
= : \ 4 Parametrische modellen
&  02_Constructie coordinatie mode! NL Duplicate D
“ 03_Installatie coordinatie model NL Rename. . a IFC Bouwkundig model
o & o Od_BOUWkunde parametriSCh model lFC Constructie model
& 05_Constructie parametrisch mode! NL Delete - Lt dal
& 06_Installatie parametrisch mode! NL Browse nsialiatie mode
~  BIMRVB BIM Norm NL/BE
— BIM modelchecking en hoeveelheden Algemeen @
- COBie 2 COBie [ X
— Exact Geometry Export BuildingSM/ > View Properties
« Freeform mocellen Algemeen =
H € € General Translator Algemeen Format
- IFC4 Design Transfer View Algemeen IFC file
—> IFC4 Reference View Algemeen
04 Bouwkunde parametnsch model
Translators...
PUbIIShInq SEt Crop image to Zoom
Biedt de mogelijkheid om de translator en zichtbare geometrie vast te leggen. Created: >
In de KeyMember Template staat bij de Publisher set een onderdeel 'O4 IFC Uitwisseling’ als aanzet klaar. Publish Lo >

Tip & Truc 096: Het instellen van een IFC translator
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Uitwisseling met externe partijen

Importeren van een IFC-model

4.Visuele Controle van het IFC model in een viewer

Bijvoorbeeld Solibri Model Viewer (gratis)

Verschil Viewer / Modeler:
Een Viewer leest enkel de informatie die in het IFC bestand is opgenomen

Een Modeler vertaalt informatie naar zijn eigen gereedschappen

3. Kies een IFC Translator
Lees de bijbehorende omschrijving

2.File > Open of File > Interoperability > Merge
Denk aan de juiste verdiepingenstructuur ’

1. Filteren van Informatie Format: = IFC 2x3 file

Alleen zichtbaar maken van informatie die je wil zien Export: Visible elements (on all stories) Model Filter...
Translator: General Translator Settings...
Verberg extensie = Nieuwe map Annuleer

Tip & Truc 071: Een IFC model in ARCHICAD importeren




Uitwisseling met externe partijen

Translator - Import

¥ Import/Export Filter Options

Filter Model Elements to Convert by
IFC Domain:

Structural Function:

| Convert IFC Annotations and ArchiCAD 2D elements

Convert Grid elements

| Convert 2D symbols of Doors and Windows
¥ Import Options

Show Model Filter on import

Geometry Conversion

Layer Conversion
N « ®
' Keep original layers
O Keep original layers and add extension:

N
' Place elements on one layer:

Material and Surface Conversion
Material import method for IFC Materials:
| Use material mapping

Building Material for non-mapped materials:

All Options...
All elements
GRAPHISOFT.
Conversion Options...
& IFCBWKP

Create attributes from IFC Materials

o

ALG - CONSTRUCTIEF

Generate Surface Attributes from IFC geometry Surface overrides

Renovation Status Conversion

Replace missing Renovation Status with:

Existing

@ Filter by Element Type

IFC Domain: All

o

¥ ™ IfcElement
¥ M IfcBuildingElement
IfcBeam
v ¥ IfcBuildingElementComponent
IfcBuildingElementPart
v M IfcReinforcingElement
IfcReinforcingBar
IfcReinforcingMesh
IfcTendon
IfcTendonAnchor
IfcBuildingElementProxy
IfcColumn
IfcCovering
IfcCurtainWall
IfcDoor
IfcFooting
IfcMember
IfcPile
IfcPlate

Filter

Geometry Conversion Options

Building elements:

Distribution elements:

Other elements:

IFC Site geometry:

Unnamed complex IFC profiles:

Construction elements, otherwise Morphs

Morphs

Morphs

Morphs

Custom profiles

ofofofofo

Cancel

@ Material Mapping
IFC Material A ArchiCAD Building Material
CONCRETE/B15 .. Beton gewapend C
CONCRETE/B25 [T Beton gewapend C
CONCRETE/B35 ] Beton gewapend C
CONCRETE/B45 [ Beton gewapend C
CONCRETE/B55 ] Beton gewapend C
CONCRETE/B65 ] Beton gewapend C
CONCRETE/BAKSTEEN VIl steen - Baksteen
CONCRETE/BESTAAND_BE... ] Beton gewapend C
CONCRETE/C100/115 ] Beton gewapend C
CONCRETE/C12/15 .. Beton gewapend C
CONCRETE/C20/25 .. Beton gewapend C
CONCRETE/C28/35 ] Beton gewapend C
CONCRETE/C35/45 [T Beton gewapend C
CONCRETE/C45/55 ] Beton gewapend C
CONCRETE/C53/65 ] Beton gewapend C
CONCRETE/C60/75 ] Beton gewapend C
CONCRETE/C70/85 ] Beton gewapend C
CONCRETE/C80/95 ] Beton gewapend C
................. [ | o S ‘-
New Merge from IFC...

Informatie
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“Open BIM"

wisselwerking -

"

BIM Collaboration Format
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BCF

Bestandsformaat

BCF staat voor Building Collaboration Format en wordt gebruikt om met verschillende partijen over ‘issues’ in modellen te
communiceren, onafhankelijk van de modelleer software die gebruikt wordt.

BCF wordt evenals IFC ontwikkeld door BuildingSmart.

Werkwijze

Aan elk modelelement hangt een unieke code (GUID) die bij de export naar IFC meegenomen wordt.

Hierdoor is het mogelijk commentaren, afbeeldingen en andere informatie aan een specifiek element te koppelen.

De ontvanger van een BCF bestand kan op een 'issue’ klikken en zo doelgericht de juiste elementen in het model opsporen en problemen

oplossen.
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BIMCollab

Bedoeling van BiIMcollab

Het opslaan van Issues in the ‘Cloud’

Het heen en weer sturen van BCF bestanden kan tijdrovend en overzichtelijk worden. Met name in
latere fases als meerdere partijen bij een project betrokken zijn.

Ook beschikt niet elk partij over een BIM applicatie.

Werkwijze

» Maak een project account op
http://www.bimcollab.com/en/Get-started/Pricing/join-bimcollab

» De bij een project betrokkenen partijen maken via de BCF Manager een verbinding met dit
account, onafhankelijk van de gebruikte software.

- BCF bestanden hoeven nu niet meer heen en weer gestuurd te worden. In plaats ervan wordt
gebruik gemaakt van een synchronisatie knop in de BCF Manager.

» Partijen zonder BIM pakket kunnen via een webbrowser op de projectsite inloggen en daar alle
ISsues Inzien.

Closed, Normal

Resolved, Norma
UITVOERINGSFASE UITVOERINGSFASE
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& BIMcollab

My projects Issues [Search project

My first BIMcollab project

Project leader: Chris Dalhuizen 8- 7
Start date: 17-12-2014
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BCF Manager

Gratis Plugin voor verschillende BIM-software.
Niet alleen geschikt voor het gebruik in externe communicatie, maar ook handig om onderdelen in het eigen model snel uit te lichten.
http://www.bimcollab.com/en/Support/Support/Downloads

ARCHICAD Connection Add-In for Autodesk Revit

Deze Gratis Plugin optimaliseert de [FC uitwisseling tussen ARCHICAD en Reuvit.
http://www.graphisoft.com/downloads/interoperability.html

Bond Bryan BIM Blog

Een interessante Blog pagina.

Hier worden verschillende stappen in het BIM-proces worden uitgelicht aan de hand van Lego-blokken.
http://bimblog.bondbryan.com

IFC optimizer

Dit programma reduceert de omvang van het IFC-bestand.
http://www.kubusinfo.nl/Solibri/Solibri/IFC-Optimizer




